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This  section of  the  User’s  Guide  provides  instruction on using  the  CH4 and  N2O Stationary  
Combustion  module  of  the  State  Inventory  Tool  (SIT),  and  describes  the  methodology  used 
for  estimating  greenhouse  gas emissions from  stationary  combustion  at  the  state  level. 
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1.1  GETTING  STARTED  

The  Stationary  Combustion1  module  was  developed  using  Microsoft®  Excel  2000.   While  the  
module  will operate  with  older  versions  of  Excel,  it  functions  best w ith  Excel 2000  or  later.   
If  you  are  using Excel  2007  or  later,  instructions  for  opening  the  module  will v ary  as  
outlined  in  the  Excel  basics  below.  Before  you  use  the  Stationary  Combustion  module,  make  
sure  your  computer  meets  the  system  requirements.   In order  to  install  and  run the  
Stationary  Combustion  module,  you  must  have:  

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation. To check this setting, launch Microsoft Excel before opening the 
Stationary Combustion module. Go to the Tools menu and select “Options...” Click on the 
“Calculations” tab and make sure that the radio button next to “Automatic” is selected, and 
then click on “OK” to close the window. The security settings (discussed next) can also be 
adjusted at this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu. 

Microsoft Excel Security 

Excel 2003 and Earlier: Since the SIT employs macros, you must have Excel security set 
to medium (recommended) or low (not recommended). To change this setting, launch 
Microsoft Excel before opening the Stationary Combustion module. Once in Excel, go to the 
Tools menu, click on the Macro sub-menu, and then select “Security” (see Figure 1). The 
Security pop-up box will appear. Click on the “Security Level” tab and select medium. 
When set to high, macros are automatically disabled; when set to medium, Excel will give 
you the choice to enable macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros. Macros must be enabled in order for the Stationary Combustion module to 
work. Once they are enabled, the module will open to the control worksheet. A message 

1  Due to nuances associated with estimating non-CO2  emissions associated with combustion,  there are  
three modules focusing on emissions from combustion: the  CO2  FFC module (which calculates CO2), 
the stationary  combustion  module (which calculates  CH4  and N2O),  and  the  mobile  combustion module  
(which calculates CH4  and N2O  from transportation activities).  
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box  will  appear  welcoming  the  user  to  the  module.   Clicking on  the  “x”  in  the  upper-right-
hand  corner  of  the  message  box  will  close  it.  

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the Stationary Combustion module is 
initially opened. The Security Warning lets the user know that some active content from the 
spreadsheet has been disabled, meaning that Excel has prevented the macros in the 
spreadsheet from functioning. Since SIT needs macros in order to function properly, the 
user must click the “Options” button in the security message and then select, “Enable this 
content” in the pop-up box. Enabling the macro content for the SIT in this way only enables 
macros temporarily in Excel but does not change the macro security settings. Once macros 
are enabled, a message box will appear welcoming the user to module. Click on the “x” in 
the upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros. To change the setting, first exit out 
of the Stationary Combustion module and re-launch Microsoft Excel before opening the 
Stationary Combustion module. Next, click on the Microsoft Excel icon in the top left of the 
screen. Scroll to the bottom of the menu and select the “Excel Options” button to the right 
of the main menu. When the Excel Options box appears, select “Trust Center” in left hand 
menu of the box. Next, click the grey “Trust Center Settings” button. When the Trust 
Center options box appears, click “Macro Settings” in the left hand menu and select “Disable 
all macros with notification.” Once the security level has been adjusted, open the 
Stationary Combustion module and enable macros in the manner described in the preceding 
paragraph. 

Viewing and Printing Data and Results 

The Stationary Combustion module contains some features to allow users to adjust the 
screen view and the appearance of the worksheets when they are printed. Once a module 
has been opened, you can adjust the zoom by going to the Module Options Menu, and either 
typing in a zoom percentage or selecting one from the drop down menu. In addition, data 
may not all appear on a single screen within each worksheet; if not, you may need to scroll 
up or down to view additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the Stationary Combustion module are printed. To do so, go to the File menu, and then 
select “Print Preview.” Click on “Page Break Preview” and drag the blue lines to the desired 
positions (see Figure 2). To print this view, go to the File menu, and click “Print.” To return 
to the normal view, go to the File menu, click “Print Preview,” and then click “Normal View.” 
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Figure 1. Changing Security Settings Figure  2.   Adjusting  Print Margins  
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1.2  MODULE  OVERVIEW  

This User’s Guide accompanies and explains the Stationary Combustion module of the SIT. 
The SIT was developed in conjunction with EPA’s Emissions Inventory Improvement 
Program (EIIP). Prior to the development of the SIT, EPA developed the States Workbook 
for estimating greenhouse gas emissions. In 1998, EPA revisited the States Workbook and 
expanded it to follow the format of EIIP guidance documents for criteria air pollutants. The 
result was a comprehensive, stepwise approach to estimating greenhouse gas emissions at 
the state level. This detailed methodology was appreciated by states with the capacity to 
devote considerable time and resources to the development of emission inventories. For 
other states, the EIIP guidance was overwhelming and impractical for them to follow from 
scratch. EPA recognized the resource constraints facing the states and developed the SIT. 
The ten modules of the SIT corresponded to the EIIP chapters and attempted to automate 
the steps states would need to take in developing their own emission estimates in a manner 
that was consistent with prevailing national and state guidelines. 

Since most state inventories developed today rely heavily on the tools, User’s Guides have 
been developed for each of the SIT modules. States interested in reviewing detailed 
methodological information should consult Volume VIII of the EIIP guidance documents. 
Even though the greenhouse gas volume will not be updated on a regular basis, it provides 
additional information and in some cases, alternate approaches not found in the SIT or the 
companion User’s Guide. 

The  Stationary  Combustion  module  calculates  methane  (CH4)  and  nitrous  oxide  (N2O)  
emissions for the  fuel  types  and  end-use  sectors indicated  in  Table  1    While  the  module  
provides  default data  for  fuel  types  (where  possible),  users  are  encouraged  to  input state-
specific  default  data  if  it  is  available.   If using  outside  data  sources, or  for a  more  thorough  
understanding  of  the  approach  used  to  estimate  emissions,  please  refer to  the  following  
discussion  for  data  requirements  and methodology.  

1.2.1  Data Requirements  

To  calculate  CH4 and  N2O emissions from  stationary  combustion,  the  following  data  are  
required:  
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• Fossil fuel consumption by fuel type and sector; 

• Wood consumption by sector; 

• Non-energy consumption by fuel type for the industrial sector; and 

• Emission factors by fuel type and sector. 

Since  the  CH4  and  N2O emission  factors  vary  by  fuel  type,  it  is  necessary  to compile  
consumption  data  for  the  fuel  types provided  in Table  1.  

Energy consumption statistics should be collected on 
an energy basis—preferably in British thermal units 
(Btu). Statistics providing energy consumption data 
in other units, such as barrels or tons, may be used, 
but require conversion to Btu by using the heat 
content of the specific fuel. If the conversion to 
energy units is necessary, the heat contents that 
were used should be documented. Please note that 
even data given in Btu may be preceded by a prefix 
indicating order of magnitude (i.e. thousand, 
million, billion). For a better understanding of the 
quantity prefixes used with Btu, refer to Box 1. 

Box 1: Energy Units 
A British thermal unit (Btu) is the quantity 
of heat required to raise the temperature of 
one pound of water one degree Fahrenheit 
at or near 39.2 Fahrenheit. 

Btu British thermal unit 1 Btu 
MBtu Thousand Btu 1x103 Btu 
MMBtu Million Btu 1x106 Btu 
BBtu Billion Btu 1x109 Btu 
TBtu Trillion Btu 1x1012 Btu 
QBtu Quadrillion Btu 1x1015 Btu 

State Greenhouse Gas Inventory Tool User’s Guide for the Stationary Combustion Module 
1.5 



                                                       

                    
     

 
 

       
    

   
 

 
 

 

     
 

   
   
   

 
 
 

 
   
   
   

 
   

 
   
 

 
   
   
   
   
    
   
   
     
   

  
 

   
 

   
   
   
   
   
   
   

 
 

   

 

 
   
   
   
 

    

    

      

Module 2 – Stationary Combustion Module November 2019 

Table 1. Fuel Types Consumed by Sector 
Residential Commercial Industrial Electric Utilities 
Coal Coal Coking Coal 

Independent Power 
Coal 
Other Coal 

Coal 

Natural Gas Natural Gas Natural Gas Natural Gas 
Petroleum: 
Distillate Fuel 
Kerosene 
Hydrocarbon 

Gas Liquids 

Petroleum: 
Distillate Fuel 
Kerosene 
Hydrocarbon 

Gas Liquids 
Motor 

Gasoline 
Residual Fuel 

Petroleum: 
Distillate Fuel 
Kerosene 
LPG 
Motor Gasoline 
Residual Fuel 
Lubricants 
Asphalt & Road Oil 
Crude Oil 
Feedstocks 

Napthas < 401ºF 
Other oils > 401ºF 

Misc.  Petroleum 
Products 

Petroleum Coke 
Pentanes Plus 
Still Gas 
Special Naphthas 
Unfinished Oils 
Waxes 
Aviation Gasoline 

Blending 
Components 

Motor Gasoline 
Blending 
Components 

Petroleum: 
Distillate Fuel 
Residual Fuel 
Petroleum Coke 

Wood Wood Wood Wood 

Other Other Other Other 

Source: U.S. EPA 2019. 

1.2.2  Tool Layout  

Since  there  are  multiple  steps to  complete  within  the  Stationary  Combustion  module,  it  is  
important to  understand  the  module’s  overall  design.   The  layout  of  the  Stationary  
Combustion  module  and  the  purpose  of  its  worksheets  are  presented  in  Figure  3.    
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Figure 3. Flow of Information in the Stationary Combustion Module* 

*  These  worksheets  are  the  primary  worksheets  used  in the  Stationary  Combustion  module; subsequent 
worksheets  are  used  to  populate  the  default data  and  are  provided for  informational p urposes  only.  

1.3  METHODOLOGY  

This section  provides instructions for  using  the  Stationary  Combustion  module  of  the  SIT  to  
estimate  CH4  and  N2O  emissions from  sectors  that  consume  fossil  fuels  and  wood.   Within  
the  Stationary  Combustion  module,  these  sectors are  residential,  commercial,  industrial,  
and  electric  power.   Since  the  
methodology  is  similar  in  all  sectors,  a  
general  methodology  is  discussed and  
specific  examples  for each  sector are  
provided.  

Box 2: State Energy Data Sources 
In-state  sources, such as  state  energy  commissions  or  public  
utility  commissions, should  be  consulted  first.  Otherwise,  
default data  provided  by  the  Stationary  Combustion  module  
may  be  used.   Fuel  statistics  should  be  provided  on  an 
energy  basis  (e.g., in Btu).   The  Stationary  Combustion  module  

automatically  calculates emissions 
after  you  enter  energy  consumption  data  (and the  factors  on  the  control  worksheet).   The  
tool  provides  default  energy  consumption  data,  which  comes  from  the  EIA’s  State  Energy  
Consumption,  Price,  and  Expenditure  Estimates  (SEDS)  EIA  (2019).2   However,  other  more  
state-specific  data  may  be  used  if  available  (see  Box  2  for s uggestions  on where  to  find  
data).    

The  Stationary  Combustion  module  follows t he  general  methodology  outlined  in  the  EIIP  
guidance,  however  because  of  the  automation  of  the  calculations  within  the  tool,  the  order  
of steps  discussed  in  this User’s Guide  do  not follow  the  order  of  steps  discussed  within  the  
EIIP  guidance  document.   This User’s  Guide  provides  an  overview  of  the  estimation  
methodology  used  in  the  Stationary  Combustion  module  by  walking  through  the f ollowing  
eight  steps: (1) select a  state; (2) complete  the  bulk  data  energy  consumption  worksheet; 
(3) enter  emission  factors  for the  residential  sector  and  view  estimates; (4) enter emission  

2  These data are available at  https://www.eia.gov/state/seds/.  
State Greenhouse Gas Inventory Tool User’s Guide for the Stationary Combustion Module 
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factors for the commercial sector and view estimates; (5) enter emission factors for the 
electric power sector and view estimates; (6) enter emission factors for the industrial sector 
and view estimates; (7) review summary information; and (8) export data. 

The  general  equation  used  to  calculate  CH4  and  N2O  emissions  from  fuel  combustion  in  the  
residential,  commercial,  and  electric power  sectors  is shown in Equation  1.   The  equation 
used  for  fuels  in  the  industrial  end-use  sector  is  similar,  but  includes  the  non-energy  use  of  
fuels,  as  shown  in  Equation 2.  

Equation 1. General Emission Equation 

Emissions  (MMTCO2E) =  
Consumption  (BBtu)  × Emission  Factor  (MT/BBtu)  × GWP   

÷ 1,000,000 (to yield  MMTCO2E)  

Equation 2. Emission Equation for the Industrial Sector 

Emissions  (MMTCO2E) =  
[Total  Consumption  (BBtu) –  Non-Energy  Consumption  (BBtu)]   

×  Emission  Factor  (MT/BBtu)  ×  GWP   
÷ 1,000,000 (to yield  MMTCO2E)  

Step (1) Select a State 

To begin, select the state you are interested in evaluating. By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool. 

Step (2) Complete the Bulk Energy Consumption Data Worksheet 

The e nergy  consumption data  entered  in the  “Bulk  Energy  Consumption  Data”  (bulk  data) 
worksheet feed  into  the  calculation  worksheets  for  each  sector.  Modifying  the  consumption  
data  in  this  worksheet  will  change  the  consumption  estimates  on  each  sector  calculation  
worksheet.  The  default data  are  automatically  populated  in  the  yellow  cells  by  sector  and 
fuel  type  for  the  selected  state.  On the bulk  data  worksheet,  presented  as  an  example  in  
Figure  4,  the  yellow  cells  indicate  where  the  required  energy  activity  data  are  entered  either 
manually  or  automatically  from d efault  data.   Default  data  in  the  yellow  cells  on  this  
worksheet can  be  overwritten  with  state-specific  data.  To  revert to  default data  for a ll  
sectors  and  fuel  types,  click  on  the  "Refresh  Default Data"  button  at the  top  of  the  
worksheet.  Energy c onsumption  data  from  the  CO2  FFC  module  can  also  be  copied  and 
pasted directly  into  the  input  space  on  the  bulk  data  worksheet  to ensure  identical  energy  
consumption  inputs  are used  in both modules.  To  copy  and  paste  values  from  the  CO2  FFC  
module,  have  both  modules  open and  highlight the  data  that will  be  copied  from  the  CO2  
State Greenhouse Gas Inventory Tool User’s Guide for the Stationary Combustion Module 
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FFC module. Next, elect Edit/Copy from the menu bar. In the Stationary Combustion 
module, select the cell(s) where the data will be pasted into, and select Edit/Paste 
Specials/Values. Click on the "Proceed to Calculation Worksheet" button to begin/continue 
estimating emissions, or click on the “Return to Control” button to return to the control 
worksheet to continue entering emission factors. 

Figure 4. Example of the Required Energy Consumption Data in the Bulk Data 
Worksheet 

Required Energy Data 

Refresh Default Data Proceed to Calculation 
Worksheets 

Return to Control 

                                                       

                    
     

          
           

          
              
     

           
 

 

           
      

   

 

   
 

  

Step (3) through Step (5) Enter Emission Factors for Each Sector (Excluding 
Industrial Sector) and View Emission Estimates 

Control Worksheet 

For each  sector,  you  must  enter the  relevant  emission  factors  on  the  control  worksheet  
before  proceeding  to  each  individual  sector  worksheet  to  view  estimates.   Either select  the  
default  data  provided  or  enter user-specified,  fuel  and  sector-specific emission  factors  that 
will  be  used  throughout the  tool.   To  proceed  with  the  default  data,  select the  
“Check/Uncheck  All”  button  for e ach step  (residential,  commercial,  electric  power,  and  
industrial)  or  check  the  default box  directly  to  the  right of  individual yellow  input  cells.   Note  
that this  number  can  be  overwritten  if  you  discover  that the  data  for  your  state  differ  from  
the  default data  provided  by  the  tool.   To enter user-specified inputs,  enter data  directly  
into  the  yellow  input cells.   If  the  user-specific  inputs  do  not match  the  default data  in  the  
control  worksheet  (i.e.,  the  default  value  is  overwritten),  the  text  will  appear red.  See  
Figure  5  for locations  of  the  “Check/Uncheck  All”  buttons,  individual  default  check  boxes, 
and  yellow  input cells.   Information  on  emission  factors  is discussed  below.  

State Greenhouse Gas Inventory Tool User’s Guide for the Stationary Combustion Module 
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Figure 5. Control Worksheet for the Stationary Combustion Module 
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Emission Factors 

Default emission  factors  are  provided  in  the  Stationary  Combustion  module  for  all  fuel  types  
and  sectors  and are  available  from IPCC  (2006);  however,  users  may  choose  to specify  their 
own.   Figure  6  presents  an  example  of  the  emission  factors  used  in  the  commercial  sector  
N2O  worksheet.   In  general,  emissions  of  CH4  and  N2O  will  vary  with  the  type  of  fuel  burned,  
the  size  and  vintage  of  the  combustion  technology,  the  maintenance a nd  operation  of  the  
combustion  equipment,  and  the  type  of  pollution  control  technology  used.  

N2O  is  produced  from  the  combustion  of  fuels,  with  the  level  of  N2O  emissions dependant  on  
the  combustion  temperature.  The  highest  N2O  emissions occur at  a  temperature  of  1,000  
degrees  Kelvin.   For  combustion  temperatures  below  800  or above  1200  degrees  Kelvin  
(980 to  1700  degrees  Fahrenheit),  the  N2O  emissions  are  negligible  (IPCC  1997).  

CH4,  carbon  monoxide,  and  non- CH4  volatile  organic  compounds  are unburned  gaseous  
combustibles  that are  emitted  in  small  quantities  due  to  incomplete  combustion; more  of  
these  gases  are  released  when  combustion  temperatures  are  relatively  low.   Emissions of 
these  gases  are  also influenced  by  technology  type,  size,  vintage,  maintenance,  operation,  
and  emission  controls.   Larger,  higher efficiency  combustion  facilities  tend  to reach  higher 
combustion  temperatures  and  thus  emit  less  of  these  gases.   Emissions may  range  several  
orders  of  magnitude  above  the  average  for  facilities  that  are  improperly  maintained  or 
poorly  operated,  which  is often  the  case  for  older units.   Similarly,  during  start-up periods,  
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combustion  efficiency  is lowest, causing  emissions of  carbon  monoxide  and  non- CH4  volatile  
organic compounds to  be  higher  than  during  periods  of  full  operation.    

Individual Sector Worksheets 

Navigate  to  the  individual  sector  worksheets  from  the  control  worksheet using the  gray  
arrows  to  the  right of  the  emission  factors for  each  sector.   Except for  the  industrial  sector,  
the  worksheets for each  sector have  the  same  basic set-up.   On  the  residential  N2O sector  
worksheet,  shown  in  Figure  6,  the  cells  in  the  first  column  indicate  where  the  required  
energy  activity  data  were  entered  from  the  bulk  data  worksheet.  This  activity  data  are  
converted  into emissions  (in  units  of  MMTCO2E)  using  the  emission  factors  entered  on  the  
control  worksheet,  the  energy  consumption  data  entered  on  the  bulk  data  worksheet,  and  
the  calculation method  shown in Equation  1.   Note  that consumption  data  are  entered  on  
the  bulk  data  worksheet  and  is  pulled into  the  corresponding  sector  worksheet  for each  
sector.   After  entering  or  selecting  default  data  on  the  control  and  bulk  data  worksheets,  
users  should  review  the  worksheets  to  make  sure  emission  factors  and  activity  data  are  
properly  applied.   Click  on  the  orange  "Click  here  for  the  bulk  data  worksheet."  button  to 
return  to the  energy  consumption  data  entry  worksheet.  An  example  of  a  CH4  worksheet  for  
the  electric  power sector is  shown  in  Figure  7.  

The  activity  data  used  to  populate  the  energy  consumption  input  cells is  annual s tate  energy  
consumption  data  based  on  primary  fuel  type  (e.g.,  coal,  petroleum,  and  natural  gas) and  
secondary  fuel  type  (e.g.,  gasoline,  residual  oil,  natural  gas,  etc.)  by  sector  (e.g.,  
residential,  commercial,  industrial,  and  electric  utilities).   A  list of  potential  fuel  types  
consumed  in  each  sector is  provided  in  Table  1  and  is  included  in  the  Stationary  Combustion  
module.    

The  Stationary  Combustion  module  calculates  emissions  for  each  sector  by  multiplying  
consumption  by  the  appropriate  emission  factor to   obtain  the  total  CH4  or N2O  emissions in  
metric  tons.   Then,  the  total  emissions  are  converted  into MMTCO2E,  by  multiplying  by  the  
GWP  (25  for CH4  or 298  for N2O)3  and  dividing  by  106  to  express emissions in  MMTCO2E  
(Equation  1).  

3  The  decision  was  made  in  the  January  31,  2014  “Report  of  the  Conference  of  the  Parties  
on  its  nineteenth  session,  held  in  Warsaw  from  11  to 23  November  2013.”  These  global  
warming  potential  values  were  agreed  upon  by  decision  24/CP.19.  
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Box 3: Caution When Using Non-Default Fuel Consumption Data 

If you use fuel consumption data that is different from the default data, please be aware of 
double counting.  For example, EIA’s SEDS data for industrial coal consumption includes coal 
used to make synthetic natural gas, which is accounted for in both industrial coal and natural 
gas consumption data.  This double-counting issue has been corrected for in the default dataset 
contained in the Stationary Combustion module; similar adjustments may need to be made to 
outside data sources.  State-specific natural gas data can be obtained from Table 12 of EIA’s 
Historical Natural Gas Annual EIA (EIA 2001) and Table 8 of EIA’s Natural Gas Annual EIA (EIA 
2018) (and is also provided in the Stationary Combustion module).  

Figure  6.  Example of  the Required Energy Data  and  Emission  Factors  Applied  in  
the  Residential  N2O Worksheet  
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Figure  7.  Example of  the Applied D ata  in  the Electric  Power  CH4  Worksheet  

Energy Consumption 
Data 

Emission Factors 

                                                       

                    
     

 

 

         
  

 
 

 

Step (6): Enter Emission Factors and Non-Energy Use Activity Data for the 
Industrial Sector 

First,  complete  the  control  worksheet  and  bulk  data  worksheet for the  industrial  sector,  as  
described  above.   Then use  the gray  navigational  arrows  to  move  to  the  industrial  sector  
worksheets.   The  industrial  worksheets  are  unique  because  both total  energy c onsumption  
and  total  non-energy  consumption  are  required  as  inputs  to  calculate  CH4  and  N2O  
emissions,  seen  in  Figure  8 ( non-energy  input  cells  are shown in  green).   This  is  necessary  
because  most  fossil  fuels have  at  least  some  non-energy  uses.   For example,  LPG  is  used  for 
production  of  solvents  and  synthetic  rubber;  oil  is  used  to  produce  asphalt,  naphthas,  and  
lubricants;  and  coal is  used  to  produce  coke,  yielding  crude  light  oil and  crude  tar  as  by-
products  that are  used  in  the  chemical  industry.   Since  these  fuels  are  not  combusted  when  
used  for  purposes  such  as  these,  their  consumption  should  be  subtracted  from  statistics  that 
include  total  fuel  use.  

The  Stationary  Combustion  module  estimates  net combustible  consumption  by  subtracting  
non-energy  consumption from  the  total  consumption.   From  this  point forward,  the  
industrial  worksheet  functions  in  the  same  manner as  the  other sector worksheets.   The  net  
combustible  consumption  is multiplied  by  the  appropriate  emission  factor for  to  obtain  the  
total  CH4  or N2O  emissions in  metric tons.   Then,  the  total  emissions  are  converted  into 
MMTCO2E,  by  multiplying  by  the  GWP  (25  for  CH4  or 298  for N2O) and  dividing  by  106  to  
express emissions in  MMTCO2E  (Equation  2).  Click  on  the  orange  "Click  here  for the  bulk  
data  worksheet."  button  to  return  to  the  energy c onsumption  data  entry  worksheet.  
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Figure 8. Example of Energy and Non-Energy Consumption Data Applied in the Industrial 
Worksheet 

Required Non-Energy 
Consumption Data 

                                                       

                    
     

            
 

 

 

    

 
 

Step (7): Review Summary Information 

The  steps  above  provide  estimates  of  total  CH4  and  N2O  emissions  by  sector.   These  are  
summed  over  all  fuel  types  and  sectors,  for  each  year,  and  the  information  is  collected  on  
the  summary  worksheets.   There  are  three  summary  worksheets,  one  for CH4,  one  for N2O,  
and  one  for total  emissions.   Each  worksheet  displays  results in  MMTCO2E.   Figure  9  shows 
the  summary  worksheet  that  sums the  emissions from  all  sectors in  the  Stationary  
Combustion  module.   In  addition,  the  results  are  displayed  in  graphical  format at the  bottom  
of  each  summary  worksheet.    
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Figure  9.   Example  of  the  Emissions  Summary  Worksheet  in  the  Stationary Combustion  
Module  

Step (8): Export Data 

The final step is to export the summary data. Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
greenhouse gas inventory for the state. 

To  access  the  “Export  Data”  button,  return  to  the  control  worksheet  and  scroll  down to  the  
bottom  (8).   Click  on  the  “Export Data”  button  and  a  message  box  will  open  that reminds  
the  user to make  sure  all  sections of the  module  have  been  completed.   If  you  make  any  
changes  to  the  Stationary  Combustion  module  later,  you  will  then  need  to re-export the  
results.  

Clicking “OK” prompts you to save the 
file. The file is already named, so you 
only need to choose a convenient place 
to save the file. After the file is saved, a 
message box will appear indicating that 
the data was successfully exported. 
State Greenhouse Gas 

Note: the resulting export file  should not be  
modified.   The  export file  contains  a  summary  
worksheet that allows  users to  view  the  results, as  well a s  
a  separate  data  worksheet with an unformatted  version of  
the  results.  The  second  worksheet, the  data  worksheet,  
contains  the  information  that is  exported  to  the  Synthesis  
Tool.  Users  may  not  modify that worksheet.   
Adding/removing  rows,  moving  data, or  making  other  

  Gmuodidifeic aftior ons th jeeo Spatradtizione  the ary a bCiliomty  obf  uthe st iSonynthe Modsis u le     
Module  to  accurately  analyze  the  data.   
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While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 

Following data export, the module may be reset and run for an additional state. 
Alternatively, you may run the remaining modules of the State Inventory Tool to obtain a 
comprehensive profile of emissions for your state. 

1.4  UNCERTAINTY  

In the upper right-hand corner of the Summary worksheets is a button: “Review discussion 
of uncertainty associated with these results.” By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 
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